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End-User License Agreement (EULA) of Graphtec Studio 2
This End-User License Agreement ("EULA") is a legal agreement between the licensee ("you") and Graphtec 
Corporation ("Graphtec"), relating to the Graphtec Studio 2 software ("Software"), authored by Silhouette Research 
& Technology Ltd ("Author").  
This EULA governs your acquisition and use of the Software directly from Graphtec or indirectly through a 
Graphtec authorized reseller or distributor.  
Please read this EULA carefully before completing the installation process and using the Software. It provides a 
license to use the Software and contains liability disclaimers.  
If you register for a free trial of the Software, this EULA will also govern that trial. By clicking "accept" or installing 
and/or using the Software, you are confirming your acceptance of this EULA and agreeing to become bound by its 
terms.  
If you are entering into this EULA on behalf of a company or other legal entity, you confirm that you have the 
authority to bind such entity and its affiliates to these terms and conditions. If you do not have such authority or if 
you do not agree with the terms and conditions of this EULA, do not install or use the Software, and do not accept 
this EULA.  
This EULA shall apply only to the Software supplied by Graphtec herewith regardless of whether other software is 
referred to or described herein. The terms also apply to any updates, supplements, Internet-based services, and 
support services for the Software, unless other terms accompany those items on delivery. If so, those terms apply.

Disclaimer
This Software and accompanying files and documentation are distributed "as is" and without any warranties as to 
performance or merchantability or any other warranties whether expressed or implied.  
You agree to bear the entire risk as to the use of this Software. Graphtec does not assume liability for the use of 
this Software beyond the original purchase price. In no event may Graphtec, its suppliers, or the Author be liable 
for additional direct or indirect damages including any lost profits, lost savings, or other incidental or consequential 
damages arising from the installation of the Software or incompatibility with any computer system or technical 
limitation of the Software or use or inability to use the Software or arising from any defects, even if Graphtec has 
been advised of the possibility of such damages.  
Neither Graphtec nor the Author warrant that the functions of the Software will meet your requirements or that 
the Software is compatible with any computer system on which it is used or that operation of the Software will be 
unlimited or error free. You assume responsibility for selecting the Software to achieve your intended results and for 
the installation of, the use of and the results obtained from the Software.

License Grant
Graphtec hereby grants you an individual, non-transferable, non-exclusive license to use the Software on up to 
three (3) devices in accordance with the terms of this EULA. In group situations, where multiple persons will use 
the Software, you must obtain an individual license for each member of the group.  
You are permitted to load the Software onto a device (for example a PC or laptop) under your control. You are 
responsible for ensuring your device meets the minimum requirements of the Software.
You are not permitted to:
•	Edit, alter, modify, adapt, translate or otherwise change the whole or any part of the Software nor permit the 

whole or any part of the Software to be combined with or become incorporated in any other software, nor 
decompile, disassemble or reverse engineer the Software or attempt to do any such things.

•	Reproduce, copy, distribute or resell the Software.
•	Use the Software in any way which breaches any applicable local, national or international law.
•	Use the Software for any purpose that Graphtec considers to be a breach of this EULA.
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Intellectual Property and Ownership
Copyright
This Software, including all files, data, and documentation, is Copyright ©2022 Silhouette Research & Technology 
Ltd, All Rights Reserved, and is protected by international copyright law.  
Graphtec reserves the right to grant licenses to use the Software to third parties.

Termination
This EULA is effective from the date you first use the Software and shall continue until terminated. You may 
terminate it at any time by uninstalling and deleting all copies of the Software. It will also terminate immediately if 
you fail to comply with any term of this EULA.  
Upon termination, the license granted by this EULA will immediately terminate and you agree to cease all access to 
and use of the Software. The provisions that by their nature continue and survive will survive any termination of this 
EULA.

Governing Law
This EULA, and any dispute arising out of or in connection with this EULA, shall be governed by and construed in 
accordance with Japanese law.

Third Party Libraries used in the Software
Freetype 2 Library, Copyright © Freetype.org 2010.
Potrace Professional™, Copyright © 2001-2010 Icosasoft Software Inc. (www.icosasoft.ca). All rights reserved.
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Registered trademarks
•	The company and product names occurring in this manual are the trademarks or registered trademarks of their 

respective companies.
•	Silhouette Research & Technology Ltd retains all copyrights to the Graphtec Studio 2 software.
•	Graphtec Corporation retains all copyrights to this manual.

General precautions
•	The contents of this manual may not be copied or reproduced in any form, either in part or in whole.
•	The contents of this manual and product specifications are subject to change without notice.
•	Please note that Graphtec will not be held liable for any consequences resulting from use of this manual or 

product, regardless of any statements made above.
•	The screens used in this manual may differ from the actual screen.  

In addition, the screens and function names that have been provided is subject to change without notice.
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Chapter 1  Introduction Topics

1.1	 Introduction
Graphtec Studio 2 is an easy-to-use software that has been developed for creating and editing designs for a wide 
variety of graphics applications. 
This software has various features necessary to set the cutter settings, Tiling, and Zoom capabilities.  
Graphtec Studio 2 includes a couple of additional components that are offered as an application software, called 
"Remote Panel Utility" and "Data Link Server."  
"Remote Panel Utility" can be controlled by the PC, which means that the cutter will execute cutting or plotting 
instructions, issued. This allows the cutter to be easily saved and loaded for file management.  
"Data Link Server" can be used to save barcode information for roll media, this allows the cutter to a scan barcode 
printed on media to find corresponding data and then send the data to cutter.  
This option is very useful when cutting Sequential Print & Cut files a roll media.  
Please note not all functions are available on all models.
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Chapter 1  Introduction Topics

1.2	System Requirements
Graphtec Studio 2 requires the following system environments:

<Windows>
Supported OS
Windows 11 (Home / Pro / Enterprise / Education)
Windows 10/Windows 10 x64 Edition (Home / Pro / Enterprise / Education)
Windows 8.1/Windows 8.1 x64 Edition (Windows 8.1/ Pro/ Enterprise)

<Mac>
Supported operating systems (64Bit PC only)
Mac OS X 10.10 – 10.11 / macOS 10.12 – 10.15 / 11 / 12  

Please check our website for the latest supported OS and application.
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2.1	 Installation and Setup Steps
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2.1	 Installation and Setup Steps
Graphtec Studio 2 can be downloaded from the Graphtec website.
http://www.graphteccorp.com/support/index.html
After downloading, follow the procedure below to install the software.

Before installing Graphtec Studio 2 on a PC running Windows environments, make sure that the user has 
administrator privileges.

CAUTION

<Windows>
	 1.	 Download "GS2_x.x.x_WA_S.zip" from our website.

*	"x.x.x" represents the version number.

	 2.	 Unzip the "GS2_x.x.x_WA_S.zip" downloaded you downloaded.

	 3.	 Double-click the "GS2_x.x.x_WA_S.exe" file is created after extracting.

	 4.	 The User Account Control (UAC) prompt appears.  
Click on the "Yes" button.

	 5.	 The following installation window will appear.  
If you want to change the location for a particular folder, click the corresponding "Browse" button.  
Click on the "Next". Then, start the installation process.

	 6.	 Click on the "Finish" button.

  		  Installation process is completed.

http://www.graphteccorp.com/support/index.html
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<Mac>
	 1.	 Download "GS2_x.x.x_M6A_S.zip" from our website.  

When you download this file, it will be automatically decompressed to "GS2_x.x.x_M6A_S.dmg".  
If it is not automatically decompressed, double-click "GS2_x.x.x_M6A_S.zip" to decompress it.

	 2.	 Double-click the "GS2_x.x.x_M6A_S.dmg".

	 3.	 Double-click the "GS2_x.x.x_M6A".

	 4.	 Confirmation screen for using the application downloaded from the Internet will be displayed. Click the 
"Open" button.

	 5.	 Enter an administrator's "user name" and "password", then click "OK".

	 6.	 If you want to change the location for a particular folder, click the corresponding "Browse" button.  
Click on the "Next". Then, start the installation process.

	 7.	 Click on the "Finish" button.

  		  Installation process is completed.
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PRODUCT SUMMARY

3.1	 How to Start Graphtec Studio 2
3.2	 Graphtec Studio 2 Menu
3.3	 Cutting View Menu
3.4	 Registration Marks Menu
3.5	 Add a New Cutter
3.6	 Edit the Existing Cutter
3.7	 Remove the Existing Cutter
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3.1	 How to Start Graphtec Studio 2
For Windows, click Start menu or double-click the desktop shortcut icon.  
For Mac, double-click the application folder or the application icon within your dock to launch.
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3.2	Graphtec Studio 2 Menu
Graphtec Studio 2 screen is typically used when creating the design.

（A） （B） （E） （G）

（F）（D）

（C）

(A) Menu bar
• File	 :	The File option will allow you to use a new option, select the existing files you want to import, and exit 

Graphtec Studio 2.
• Edit	 :	This lets you edit settings for cut, copy, paste and lock objects.  

The Preferences Option will allow you to make the settings for the unit of measurement, edit language 
settings and adjust the default settings when Graphtec Studio 2 is opened.

• View	 :	This lets you show rulers, show guides, and make the settings for the snap.
• Panels	:	This lets you show each panels menu.
• Object	:	This lets you manipulate your designs, and will cover the basic features of the Object panel (Rotate, 

Replicate, Modify and Group actions).
• Help	 :	This displays the Graphtec Studio 2 version information and download web site which the latest 

user's manual.

(B) Tool bar
The Tool bar is used to assist with shortcut icons of general features like creating and saving files.

(C) Quick Access Toolbar
The Quick Access Toolbar option is a quick way to access many of the panels, such as Group Duplicate, Weld, 
etc.

(D) Design Tool
This Design Tool will allow you to enable the creation of outline and print data consisting of objects and text.

(E) Workspace
This is used to use the workspace tools to create your own objects and text.

(F) View Panels
This lets you show the panels.

(G) Panels
This Panels option will allow you to use the functions associated with the panels you open.
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3.3	Cutting View Menu
You can preview the job as well as information about the file and configure cutting conditions to be sent to the 
cutting plotter in the Cutting View screen.

（A） （B）

（C）

（D）

（E）

(A) Tool bar
This moves the object in the Preview window to its destination position. and enlarges or reduces the view of the 
cutting image.

(B) Preview window
This displays the size and cutting data of the media.  
Before you perform cutting, you can check the cutting data and configure settings such as the size and 
orientation of the media on your computer.

(C) Cutter Model used
This displays a cutting plotter name and image icon to use.  
This lets you add, edit and delete the cutting plotter to use.

(D) Output Setting Tab
This sets the cutting data sent to the cutting machine.  
Graphtec Studio 2 consists of eight tabs used to configure the cutting condition settings or operating functions.
• General tab:	 This section allows you to manually configure position and size, such as basic zoom-

in or zoom-out and rotation functions.
• Option tab:	 This section configures cutting conditions, such as the blade force, and perforated 

cutting conditions. You can schedule cuts by line color, fill color, or by layer.
*	This By Layer option is only offered as an extra-cost option.

• Advance tab:	 This section offers specialized cutting options, such as controlling the cutting order or 
cutting direction of your job.

• Weed tab:	 This Weed Line option creates a frame that surrounds the selected object in order to 
facilitate weeding the cut.

• Matrix Copy tab:	 This Matrix Copy option arranges and cuts any number of objects you have designed 
on a single piece of this minimizes media waste.
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• Registration Marks tab:	This Registration Marks option provides adjust the registration marks function ,such 
as setting the values of margins and registration marks for different media sizes.

• Tiling tab:	 This allows you to take data that is too large to fit a single piece of media and outputs 
it divided among a number of pieces of media.

• Plotter Information Tab:	Used to start the info Display and Remote Panel Utility of the cutting plotter when it is 
connected.

(E) Output Button
The cut data is sent to the cutting plotter selected in Model window.  
In addition, the transmit Type performs output of the cut data by selecting 3 Type according to the application 
and pressing the "OUTPUT" button.
"Send To Cutter"  

Send cut data to the cutting plotter.
"Send To Data Link Server"  

Send cut data to "Data Link Server".  
Select this to perform continuous operation using Roll Media Barcode.
*Only supported Model can be selected.

"Save To File"  
This saves the cut data to File.  
Select to create an XPF File or plotted File for offline OUTPUT using the USB flash drive.
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3.4	Registration Marks Menu
This lets you make the settings for the Registration Marks and Barcode for frequently used print & cut jobs.

Registration Marks/Barcode tab

Registration Marks/Barcode tab
Registration Marks screen consists of four tabs used to configure the settings for the items shown below. 
• General tab:	 This Registration Marks option allows adjusting the registration marks function, such as 

Registration Marks types, Size, and Origin Position.
• Color tab:	 This function is used for placing lines on top of registration marks and this can be used in 

combination with the colors around the square the registration marks.
• Barcode tab:	 This sets the types, lengths and location of the Barcode.
• Printer Margins tab:	This option is used on printed rolls with barcode. To set the barcode position.
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3.5	Add a New Cutter
This lets you set up a new cutter to use as the output destination for cutting data.

<How to add a new cutter when using Auto Search>
Simply click the Auto Search button and set the identified cutter to the computer that is connected.  
In order to use Auto Search, make sure that the cutting plotter is connected to the computer by using USB or LAN 
cable.

●If you wish to use an Ethernet connection, you need to configure the cutting plotter to communicate with 
your LAN.

●If you wish to use an Ethernet connection, ensure that both PC and the cutting plotter are connected to 
the same network segment.

●If the cutting plotter is connected to the computer with RS-232C connection only, then Auto Search 
option will not work.

Supplement

	 1.	 Start "Graphtec Studio 2" screen.  
From File menu, select the "Cutting View".

	 2.	 Click on the "  " icon.

	 3.	 The "Add Cutter" dialog box will appear on the display.  
Press the "Search" button.
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	 4.	 The "Select Cutter" dialog box will appear on the display.  
Available cutters will be listed that can be connected to the computer by using USB or LAN cable 
connection.  
Select the cutter that you want to connect and press "OK".

	 5.	 The selected cutter appears in the "Add Cutter" dialog box.  
If you select USB connection, "Link The Destination Cutter" will appear on the display.  
When you try to connect to multiple cutters with the same model, check the box in front of "Link The 
Destination Cutter".  
For LAN connectivity, "Connection Test" button is displayed.  
If you check to confirm the communication status with the cutter, press "Connection Test" button.  
You may change the "Cutter Name", if needed.

	 	
	 USB Connectivity	 LAN Connectivity

	 6.	 Press the "OK" button.  
The cutter setup process is now completed.

<How to add a new cutter without using Auto Search function>

You need to set the cutting plotter or interfaces to be connected manually.

	 1.	 Start "Graphtec Studio 2" screen.  
From File menu, select the "Cutting View".
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	 2.	 Click on the "  " icon.

	 3.	 The "Add Cutter" dialog box will appear on the display.  
Click the drop-down arrow for "Model", and then select the cutter that you want to connect.  
Click the drop-down arrow for "Interface", and then select Interface Types.

  		  If you select USB connection, select the "USB".  
If selected, the "Link The Destination Cutter" will appear on the display.  
When you try to connect to multiple cutters of the same model, check the box in front of "Link The 
Destination Cutter".

  		  If LAN is selected, select the "LAN".  
If selected, the "IP Address" is displayed. Just connect the cutter and write down the IP address.  
Also, the "CONNECTION TEST" button is displayed.  
The "CONNECTION TEST" button is pressed to confirm the communication status with the cutter after IP 
address is entered.

  		  If RS-232C is selected, select the "RS-232C".  
If selected, "Port", "Baud Rate", "Data Bit", "Parity" and "Handshake" are display.  
Make sure that your cutting plotter is configured for the same baud rate, parity and data bit as your 
computer's serial port.

  		  You may change the "Cutter Name", if needed.

	 	 	
	 USB Connectivity	 LAN Connectivity	 RS-232C Connectivity

	 4.	 Press the "OK" button.  
The cutter setup process is now completed.
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3.6	Edit the Existing Cutter
This will allow you to adjust your cutter settings.

	 1.	 Start "Graphtec Studio 2" screen.  
From File menu, select the "Cutting View".

	 2.	 Select the cutting plotter which you want to change the setting, click on the "  " icon.

	 3.	 The "Add Cutter" dialog box will appear on the display.  
Reconfigure the settings to be changed for different types of interfaces or cutter model.

	 	 	
	 USB Connectivity	 LAN Connectivity	 RS-232C Connectivity

	 4.	 Press the "OK" button.  
Configuration changes have been completed.
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3.7	Remove the Existing Cutter
This is used to delete a connected cutting plotter.

	 1.	 Start "Graphtec Studio 2" screen.  
From File menu, select the "Cutting View".

	 2.	 Select the cutter that you want to remove and click on the "  " icon.

	 3.	 A Delete confirmation window will appear.

	 4.	 Press "OK" button.  
The deletion has been completed.
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Chapter 4  Operation Guide for Creating 
a Design

PRODUCT SUMMARY

4.1	 Basic Operation for Drawing Tool
4.2	 How to Edit the Path
4.3	 How to Align Multiple Objects
4.4	 How to Re-size the Object
4.5	 How to Replicate the Object
4.6	 How to Create More Intricate Designs
4.7	 How to Trace Images to Create Cut Lines for Print & Cut Images (Contour Line)
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4.1	 Basic Operation for Drawing Tool
Graphtec Studio 2 allows users to draw and create images very easily through a set of basic drawing tools.  
These drawing tools are located on the left side of the screen and can be created and edited.

 Select Tool
This lets you select text, objects and images by click on them to show they are selected.  
This Select Tool determines which multiple objects are selected by hovering over them and allows you to move 
objects around on your screen.

 Edit Points Tool
This tool will allow you to edit any points of your object by moving them around or deleting them.  
Points on the line can be edited to take the line in a new direction, or changing a straight line into a curved line. To 
edit an object, you can double-click on your object again, or click the Edit Points Tool after clicking on the Select tool. 
When you enter the Point Editing Mode, selected objects will change from displaying the resizing to showing the 
points, or nodes of the image.

 Line Tool
The Line Tool includes four line choices, which consist of the Line, Curved Shape, Polygon, and Arc settings.  
When hovered over, the Line tool panel will appear. Click and hold the Line Segment tool, and you can select what 
you want to draw.

 Line Tool
The Line Tool allows for the creation of single straight lines.  
Holding down the Shift key on your keyboard while drawing will force a straight vertical, horizontal, or 45 degree 
increment line from the start point.

 Polygon Tool
The Polygon Tool allows for the creation of multiple segment lines.  
This tool will draw a point upon each mouse click. Lines will continue to be drawn until the image is closed by 
aligning the end point with the starting point, or by double-clicking the mouse to stop drawing.
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 Curved Shape Tool
The Curved Shape Tool allows for the creation of multiple curved lines.  
This tool will draw a point upon each mouse click. Lines will continue to be drawn until the image is closed by 
aligning the end point with the starting point, or by double-clicking the mouse to stop drawing.

 Arc Tool
This Arc tool allow you to draw any size arc.  
By clicking the mouse, position the pointer where you want the radius of the arc to begin, and drag to where you 
want the length of the arc to end. You can adjust the angle of the arc by clicking a red control handle, and also 
control the distance of the arc by dragging a gray control handle.

 Drawing Tool
The Drawing Tool include four choices which consist of the Rectangle, Rounded Rectangle, Ellipse and Regular 
Polygon segments.  
When hovered over, the drawing tool panel will appear. By clicking and holding the Drawing tool, you can select 
that you want to draw it.

 Rectangle Tool
This Rectangle Tool allows for the creation of a square or rectangle.  
Holding down the Shift key on your keyboard while drawing will create a square.

 Rounded Rectangle Tool
This Rounded Rectangle Tool allows for the creation of a square or rectangle with rounded corners.  
You can adjust the curves of the rectangle’s upper left-hand corner by using the two red control handles and 
dragging them.

 Ellipse Tool
This Ellipse Tool allows for the creation of an oval or circle.  
Holding down the Shift key on your keyboard while drawing will create a circle.

 Regular Polygon Tool
This Polygon Tools allows for creation of shapes with different numbers of sides.  
The slider bar can adjust the variety of polygons by dragging the handles to different shapes, such as a triangle.

 Flexishapes
The Flexishapes tool gives you access to over 60 pre-created shapes such as star or heart.

 Freehand Tool
The Freehand Tool includes two freehand choices, the Freehand and Smooth Freehand choices.  
When hovered over, the Freehand tool panel will appear. Click and hold the Freehand tool, and you can select what 
you want to draw.

 Freehand Tool
This Freehand Drawing Tool allows for the creation of a continuous free-form line.  
You can draw the lines by clicking, holding, and dragging the mouse and this tool will continue until the mouse 
button is released. A closed shape is created if the end point aligns with the start point.

 Smooth Freehand Tool
This Smooth Freehand Drawing Tool allows for the creation of a smooth, continuous free-form line.  
Lines drawn with this tool will have smooth transitions and no sharp angles. A closed shape is created if the end 
point aligns with the start point.
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 Text Tool
This will allow you to type the text.  
You can use the Text Style Panel located on the right side of the screen to apply options for formatting individual 
text.

 Memo Tool
This Memo Tool will allow you to make a note in your design.  
This Memo can be placed anywhere in the Media Workspace and the Gray Holding area.

 Eraser Tool
This Eraser Tool will allow you to easily remove inner parts or edges of the line image.  
You can edit and change an eraser shape or size in the Quick Access Tool bar above workspace. The options also 
allow us to choose between creating an open or closed eraser path.

 Knife Tool
This tool delivers a straight-line cut to separate parts of images to create a new separate independent shape.  
You can edit and change a knife shape or size in the Quick Access Tool bar above the workspace. This is also 
provided to be able to choose between creating an open or closed eraser path.
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4.2	How to Edit the Path
This Point Editing Mode will allow you to edit any point.

●General
As you double-click a selected object, you will enter Point Editing mode and the panel for editing the point will be 
displayed on the right side of the screen. Or you can choose the Quick Access Tool bar above the workspace.  
In Point Editing Mode, the selected point will be displayed in white while all other points will be dark grey.  
The selected line associated with the selected point will be emphasized as a bolded red line. Additional lines 
that have blue points are handles to adjust curved lines.  
To exit the Point Editing Mode, you may double-click on your image again, or return to the regular select mode 
by clicking on the Select tool.

Only single ungrouped object selections may be edited.  
If the Point Edit mode does not become enabled, by double-clicking, either make objects into a 
compound path or release the compound path.

Supplement
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●Add Point/Delete Point
Add a point by hovering over the line where no points currently exist where you may wish to drop a new point to 
edit your image.  
Any selected point will be deleted by simply pressing the Delete key on your computer keyboard, by accessing 
the Delete Point tool and selecting Delete the selected node, or by clicking on the Delete Point button located at 
the right side of the Point Editing Panel.

●Break Path
You may break the path of any line point by using the Break Path tool, or by right clicking on the selected point.  
You may break the outline of the shape by accessing the Break Path tool, or by clicking on the Break Path button 
located at the right side of the Point Editing Panel.  
Once the point turns red, it can be removed to split the line and any corresponding fill.

●Simplify
The Simplify tool automatically reduces the number of points in an object a shown in the example below.
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4.3	How to Align Multiple Objects
Multiple images may be aligned together in relation to each other, horizontally or vertically.  
From the Panels menu select "Transform", and you will be able to view the "Transform" panel.  
Then select the Align tab, you can adjust the setting for aligning the selected objects.

●Aligning

Center (Align Center-Middle)
This option will center two or more selected objects so that they are lined up with each other in the middle of 
each other to the page.

Center
This option will align two or more selected objects so that their center points are aligned together.

Horizontal
This option will align two or more selected objects to the horizontal left, center, and right edge of your design.

Vertical
This option will align two or more selected objects to the vertical left, center, and right edge of your design.

●Spacing

Horizontal
This option will take all images and space them horizontally so that all objects are equidistant from each other 
horizontally.

Vertical
This option will take all images and space them vertically so that all objects are equidistant from each other 
vertically.
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4.4	How to Re-size the Object
This Scale menu options will allow objects to be enlarged or reduced.  
From the Panels menu, select "Transform", and you will be able to view the "Transform" panel.  
Then select Scale tab, you can resize the objects by one of the pre-set percentages of values.

●Scale
This option will resize any selected image by a percentage of its current size.

●Specify Dimensions
This option will allow you to resize a selected image to any specific measurement.  
If you wish to specify the specific size individually for the height and width, make sure the Lock aspect Ratio is 
unchecked at the right-side panel.
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4.5	How to Replicate the Object
The Replicate option will create any number of copies and place them at once.  
From the Panels menu, select "Replicate", and you will be able to view the "Replicate" panel.  
Then select the Replicate tab, you can adjust the setting for duplicating the selected objects.

●Replicate
Duplicate
This option will duplicate the selected object and place a copy directly to the left, right, above and below.

Rows and Columns
This option will copy the selected object and replicate three or four additional copies next to each other in a row 
or column.

Fill Page
This option will copy and replicate the selected object and fill the cutting area with as many copies as possible.

In the Advanced options menu, you can specify any desired number of copies to replicate.Supplement

●Replicate

Mirror
This option will copy the mirrored copy to the left, right, above and below.

Rotate Copies
These options will copy the selected object and replicate one through five rotated copies on top of the original 
object.

The Advanced options menu allows you to specify any number of copies and angle to replicate your 
selected object.

Supplement
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4.6	How to Create More Intricate Designs
You can use the Modify menu features to easily weld and overlap objects to make more intricate patterns.  
From the Panels menu, select "Modify", and you will be able to view the "Modify" panel.

●Modify
Weld
This will take two or more selected overlapping objects and join them together into one single continuous image.

Subtract All
This option will remove any portion of an image that is in back behind another object.

Divide
This option will create individual images from the intersections of up to eight selected objects.

Subtract
This option will remove all overlapping parts of images that are in front of other images, so that only the image 
located in back will remain with the overlapping parts removed.

Intersect
This option will leave only the overlapping part, or intersecting part, of the selected images when applied.

      

Crop
This option will remove all areas that are not shared by at least two shapes when overlapping.
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●Compound Paths
Make
The object is actually made up of two layers. The filled areas are compounded and moved to the background.  
When a design is compounded, there is a hollowed-out area at the compound site.

         
When you make a compound path with multiple designs, even numbered layers from the back are compounded 
and will be entirely transparent. The fill and stroke may be applied of the backmost object.  
When a design is compounded, there is a hollowed-out area at the compound site.

         

Release
Release the compound path.

            

●Detach lines
Detach lines
When images are filled or have thick lines defined, this option may be used to detach and move the outline to 
create two separate images.
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4.7	How to Trace Images to Create Cut Lines for Print & Cut Images (Contour Line)

This option will provide a traced line contour around all parts of the yellow preview area displayed.

Trace images

	 1.	 From File menu, select "Merge".

	 2.	 Open and select your image file that you want to trace, then press the "OK".

	 3.	 When the image is placed, you may adjust your settings (size and position), if needed.

	 4.	 From the Panels menu, select "Trace", and you will be able to view the "Trace" panel.  
Then select the Replicate tab, you can adjust the setting for duplicating the selected objects.  
Click the "Select Trace Area" in the Trace panel on the right side.  
With the image selected, drag the box around the area that includes everything you want to trace.  
The default trace settings will apply automatically, highlighted in yellow.

   

When there is little contrast, it is difficult to get a good trace.Supplement
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	 5.	 Move the threshold bar until you get yellow shading your image completely.  
When completed, select the "Trace Style".  
If you cut all of the edges inside and outside of the image, click "Trace".  
If you trace just the outer edge for cut line, select the "Trace Outer Edge".  
Then, you can see the red cut lines around the area.

　

	 <When selected "Trace">	 <When selected "Trace Outer Edge">

	  	  

When creating a label by tracing an image, select the "Trace Outer Edge".Supplement

To Create Cut Lines for Your Image

	 1.	 Move to your image separate the image from the cut line.

	 2.	 From the Panels menu select "Offset", and you will be able to view the "Offset" panel.  
Select the cut lines and click "Offset".  
Move the distance bar to adjust the offset distance. Click the "Apply".
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	 3.	 Remove the inside cut lines.

   

	 4.	 From the Panels menu, select "Transform", and you will be able to view the "Transform" panel.  
Select the cut line images, and then your image so that their center points are aligned together horizontally 
or vertically.
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PRODUCT SUMMARY

5.1	 Basic Workflow for Registration Marks
5.2	 Basic Workflow for Print and Cut with Barcode
5.3	 Data Link Workflow for Continuous Cutting (Barcode Data Management)



39

Chapter 5  Operation with Barcode and Data Link Server Feature
Contents

Introduction Topics
Installation Guide

Basic Operation
Creating a Design

Barcode and Data Link Server
Advanced Cutting

5.1	 Basic Workflow for Registration Marks
This section explains the flow from creation of registration mark to cutting when a dedicated application is used.

Step1. Create registration mark data.
Step2. Create design data for printing and cutting.
Step3. Print design data.
Step4. Cut the printed media.

Step1. Create registration mark data.
Print & Cut uses Registration Marks to get an accurate picture of the print Position and cut Position.

A margin is necessary around the registration marks.  
The margin may be different depending on the cutter you want to use, refer to the User's manual.

Supplement

Operation

Creates a Registration Marks for printing and cutting.

	 1.	 Start "Graphtec Studio 2" screen.  
From the Panels menu, select the "Registration Marks", and you will be able to view the "Registration Marks" 
panel.

	 2.	 "Registration Marks" tab allows you to manually specify the various registration mark types, line thickness, 
and length.  
Check the box in front of the "Relative to Page", then enter the distance between the edge of the media and 
registration marks position.
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	 3.	 Registration marks are created on the design screen.

	 	
	 Registration Marks Type 1 	 Registration Marks Type 2

Step2. Create design data for printing and cutting.
Design the drawing pattern that you want to print and the contour to be cut.

Operation

	 1.	 Create the design to print for printing and cutting.

	 	
	 Registration Marks Type 1 	 Registration Marks Type 2

	 2.	 Create the contour cut lines to be cut for printing and cutting.  
It is recommended that the cut design is created on a color different from the print design.

	 	
	 Registration Marks Type 1 	 Registration Marks Type 2
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Step3. Print design data.
After creating the design data, print it on the media.

Pay attention to the following points. It may cause registration mark reading errors to occur and may not 
cut properly.
●	Set the enlarge/shrink scale to 100%.
●	Set the printing position (center/lower left etc.) so that the positional relationship between the created 

document and the printed result is the same.

Supplement

Operation

Print design data for printing and cutting.

	 1.	 Select the printer from the Print menu to print the design.

Step4. Cut the printed media.
Cut the printed media with the cutting plotter.

Operation

	 1.	 Load the Printed Media on the Cutting Plotter.

For details on how to load media, refer to User's Manual on the cutting plotter device.Supplement

	 2.	 Using the cutting plotter's POSITION (▲▼◀▶) key, move the tool to the registration mark (within the red 
rectangle).

*	Do not press Origin

	 <For grit rolling type>	 <For flatbed type >

	 	 	 	
	 Registration Marks Type 1	 Registration Marks Type 2	 Registration Marks Type 1	 Registration Marks Type 2

●	For CE LITE-50, refer to USER'S MANUAL of the main unit.
●	If you encounter Registration Marks read errors, review Setting associated with Registration 

Marks.

Supplement

	 3.	 Start "Cutting View" screen.  
From File menu, select the "Cutting View".
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	 4.	 Go to "General" tab.  
In order to match the orientation in which the media has been loaded, set Rotate to "0°".

The Rotate can be set only when using 4POINTS.
For other registration marks, load the media according to the orientation of the preview.

Supplement

	 5.	 Select "Option" tab.  
Select "By Color" to check only the colors that you want to cut.
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	 6.	 Select "Send To Cutter", press "OUTPUT" button.  
Registration marks are scanned. Cutting starts when all registration marks are detected.
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5.2	Basic Workflow for Print and Cut with Barcode
This section describes how to print and cut with the data link function of the cutting plotter after creating a standard 
barcode in dedicated application.  
The procedure to read the data linked to the barcode from the USB flash drive is explained.  
This option will only be displayed on supported models.

Step1. Create registration mark data and design data for printing and cutting.
Step2. Add barcode data.
Step3. Print design data.
Step4. Save cutting data in USB flash drive.
Step5. Cut the printed media.

Step1. Create registration mark data and design data for printing and cutting.
See "5.1 Basic Workflow for Registration Marks" to create design with registration marks for printing and cutting.

Step2. Add barcode data.
It is necessary to add barcode data in order to link the printed data for printing and cutting with the cutting data 
saved in the USB flash drive.

Operation

Create a barcode to use the data link function.

	 1.	 Start "Graphtec Studio 2" screen.  
From the Panels menu, select the "Registration Marks", and you will be able to view the "Registration Marks" 
panel.

	 2.	 Check the box in front of the "Use Barcode".  
Select the "Standard" from the "Barcode Type".  
Check the box in front of the "Keep Registration Marks".
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	 3.	 Press "Create Barcode" button.  
Barcode and Registration Marks are created on the design screen.
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	 Registration Marks Type 1	 Registration Marks Type 2

Step3. Print design data.
After creating the design data, print it on the media.

Pay attention to the following points. It may cause registration mark reading errors to occur and may not 
cut properly.
●	Set the enlarge/shrink scale to 100%.
●	Set the printing position (center/lower left etc.) so that the positional relationship between the created 

document and the printed result is the same.

Supplement

Operation

Create the design data with the Standard Barcode included for printing and cutting.

	 1.	 Select the printer from the Print menu to print the design.

Step4. Save cutting data in USB flash drive.
Create an XPF file (file dedicated to USB flash drive) and save it to USB flash drive.  
When you save cutting data and barcode information in this XPF file, the cutting plotter will be able to find the 
correct cutting data.

Operation

	 1.	 Insert the USB flash drive into the computer.

	 2.	 Start "Cutting View" screen.  
From File menu, select the "Cutting View".
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	 3.	 Press the "Save To File", and press "OUTPUT" button.

	 4.	 When "Save As" screen is displayed, specify "USB memory" and save the "XPF file".
*	You can move to USB flash drive after saving in any folder.

Step5. Cut the printed media.
Using the cutting data saved in the USB flash drive, cut the media with the cutting plotter.

Operation

	 1.	 Load the Printed Media on the Cutting Plotter.

For details on how to load media, refer to User's Manual on the cutting plotter device.Supplement

	 2.	 Insert the USB flash drive where the cut data was saved the USB flash drive slot of the cutting plotter.

	 3.	 Set the menu of cutting plotter.

FC9000/CE7000 FCX2000/FCX4000
1 Press the "PAUSE/MENU" key.

"MENU" will appear on screen
Press the "PAUSE/MENU" key.
"MENU" will appear on screen.

2 Press the " ▶ " key (LINK).
"DATA LINK" (1/2) will appear on screen.

* Make sure that your "DESTINATION" is "USB DRIVE"

Press the " ▶ " key (MEM.).
The "OFF-LINE OPERATION" (1/1) will appear on 
screen.
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FC9000/CE7000 FCX2000/FCX4000
3 Press the "3" key (BARCODE CUT).

"BARCODE TYPE" menu will appear on screen.
Press the "2" key (BARCODE CUT).
"Tool movement" will appear on screen.

4 "1"Press the key (STANDARD BARCODE).
"Tool movement" will appear on screen.

	 4.	 Using the cutting plotter's POSITION (▲▼◀▶) key, move the tool to the start mark (see figure) under the 
barcode and press the "ENTER" key.  
The barcode is scanned, then the corresponding data is read out from the USB flash drive.  
Cutting starts when all registration marks are detected.

<For grit rolling type>

Start mark Start mark

Registration Marks Type 1 Registration Marks Type 2

<For flatbed type >

Registration Marks Type 1

G0100SYAA

Registration Marks Type 2

Start mark Start mark

●	For CE LITE-50, refer to User's Manual of the main unit.
●	If the start mark cannot be scanned, check the print result of start mark and the detect start 

position etc.

Supplement
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5.3	Data Link Workflow for Continuous Cutting (Barcode Data Management)

This section describes how to print and cut with the data link function of cutting plotter after a creating roll media 
barcode in the dedicated application.  
Roll Media Barcode allows you to print and cut a complete roll of multiple jobs without operator intervention.  
This section explains how to create Roll Media Barcode jobs from PC and how to process them.  
This option will only be displayed on supported models.
Step1. Create design data for printing and cutting.
Step2. Add barcode data.
Step3. Print design data.
Step4. Save cutting data in data link server.
Step5. Start Data Link Server.
Step6. Set up cutting plotter.
Step7. Cut the printed media.

●	In continuous operation, even if the paper feed command and the cross cut command are included in 
the data, it becomes invalid.

●	It is recommended that a take-up device (Only supported models) is used during continuous operation.
●	When using a basket, please do not let the media protrude from the basket.  
If you do not use a basket, please make sure that media does not accumulate on the floor.  
If you do not take action, the media may skew.

●	When doing continuous operation, load the roll media without making slack of the medium at the back of 
the machine.

●	It cannot be used when connecting via RS-232C interface.

Supplement

Step1. Create design data for printing and cutting.
See "5.1 Basic Workflow for Registration Marks" to create design for printing and cutting.

If you want to use continuous operation, select Media Size according to Width of Roll Media you want to 
print.
If you use Roll Media with A0 Size, choose A0 (every Vertical), A1 (every Horizontal), or Media Size with 
any Length in A0 Width.

CAUTION

●	To use continuous operation, select the media size for the design according to the width of the roll media 
to be printed.

●	Create only design for printing and design for cutting. Then create registration marks and barcode in the 
next procedure.

Supplement
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Step2. Add barcode data.
When barcode cutting is performed in continuous operation, it is necessary to attach a special barcode called 
"Roll media barcode".

Operation
Create registration marks and a barcode for data link (continuous operation).

	 1.	 Start "Graphtec Studio 2" screen.  
From the Panels menu, select the "Registration Marks", and you will be able to view the "Registration Marks" panel.

	 2.	 Go to "Registration Marks" tab, this will allow you to specify the various registration mark type, line 
thickness, and length.

	 3.	 Check the box in front of the "Use Barcode".  
Click the drop-down arrow for "Barcode Type", and then select Roll Media.

	 4.	 Enter the printer margin in the "Printer Margins" tab.
*	The margins of the printer driver selected in the application are initialized in "Printer Margin".
*	When changing the printer, acquire margin information by pressing the "Get Printer Margins".

	 5.	 Click the "Create Barcode" button in the "Barcode" tab.  
Registration mark and barcode are created on the design screen.

	

G1100JMAA-R

G1100JMAA-F

	

G1100JMAA-R

G1100JMAA-F

	 Registration Marks Type 1	 Registration Marks Type 2

Registration marks are placed automatically. The position cannot be changed.Supplement
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Step3. Print design data.
After creating the design data, print it on the media.

Pay attention to the following points. It may cause registration mark reading errors to occur and may not 
cut properly.
●	Set the enlarge/shrink scale to 100%.
●	Set the printing position (center/lower left etc.) so that the positional relationship between the created 

document and the printed result is the same.
●	In continuous operation, it is necessary that two or more jobs are printed on the roll media.  

It is convenient to prepare printing and cutting data in advance and print them collectively.
●	Set the "Cross Cut" setting of the cutting plotter to OFF.

Supplement

Operation

Create a design data with the Roll Media Barcode included for printing and cutting.

	 1.	 Select the printer from the Print menu to print the design.

Step4. Save cutting data in data link server.
Create an XPF File and save it to Data Link Server.  
Since cutting data and barcode information are recorded in this XPF file, the cutting plotter will be able to find the 
correct cutting data.

Operation

Save the file for data link (continuous operation) in the personal computer (data link server).

	 1.	 Start "Cutting View" screen.  
From File menu, select the "Cutting View".

	 2.	 Click drop-down arrow for "Send to Data Link Server", and then press "OUTPUT" button to send the cut 
data.
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	 3.	 Start Data Link Server.  
Verify that File that you submitted to Cut Job List field is pending.
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Step5. Start data Link Server function.
Starts the Data Link Server to communicate between the cutting plotter and XPF File.

Operation

	 1.	 Start Data Link Server.  
Click the "Start" icon.

●	The Cutting Plotter supports only one Data Link Server.  
Connecting multiple data link servers to a single cutting plotter may not work properly.

● When using Data Link Server, connect to the interface only that uses the data link server.   
When both USB and Ethernet ports are connected at the same time, this may cause the cutter 
to not operate properly.

●	When using a data link server with network connection, always connect with a LAN connectivity.   
When connecting with wireless (Wi-Fi), it may not operate properly.

Supplement

Step6. Set up cutting plotter.
Set the data link connection method to receive cutting data from the data link server.

Operation

	 1.	 Press the "PAUSE/MENU" key.  
"MENU" will appear on screen.

	 2.	 Press the POSITION " ▶ " key (LINK).  
"DATA LINK" setting menu (1/2) will appear on screen.
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	 3.	 Press the "1" key (DESTINATION).  
"DESTINATION" menu will appear on screen.

	 4.	 "2" Press the key "SERVER (USB)" or the "3" key "SERVER (LAN) ".
*	Select the interface to which Data Link Server and cutting plotter are connected.

	 5.	 Confirm the setting and press the "ENTER "key (SET).  
Setting is confirmed and DATA LINK window (1/2) reappears.

	 6.	 Press the "PAUSE/MENU" key.  
It will return to default screen.

Step7. Cut the Printed Media.
Cut the printed media with the cutting plotter.

Operation

	 1.	 Place the printed media on the cutting plotter.

For details on how to load media, refer to User's Manual for the cutting plotter device.Supplement

	 2.	 From the cutting plotter's control panel, press "BARCODE".  
The following message is displayed.

From the menu screen, you can also enter the start screen of continuous operation.
In the basic screen, press "PAUSE/MENU".

Press the " ▶ " key (LINK).

Supplement
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"4" Press the key (CONTINUOUS OPERATION).

	 3.	 Press POSITION (▲▼◀▶) key in the control panel, move the center of tool to the start mark position of the 
black rectangle next to the barcode (See the figure below).

Registration Marks Type 1 Registration Marks Type 2

G1100JMAA-R G1100JMAA-R

15mm

X

Y
Width of push roller

Feed direction of 
media width

Align near the center of the width which is  the forward side of the start mark.

start mark

If the start mark cannot be detected, check the start mark and Position at which the start mark is 
detected.

Supplement

	 4.	 Confirm the tool position and press the "ENTER" key.  
Barcode starts to be detected, the corresponding data is read from the Data Link Server and cutting starts 
when Registration Marks are detected.
*	While the Continuous Operation is performed, once the cutting of the first data is completed, it will automatically 

detect the barcode for the second data and then cut.  
This process of detecting and cutting will repeat itself automatically until all remaining barcodes have been read and 
files have been cut.

*	If media skew is higher than the value specified in "automatic skew detection" setting in the cutter, continuous 
operation stops preventing media misalignment.
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Chapter 6  Advanced Cutting for  
a Specific Application

PRODUCT SUMMARY

6.1	 How to Use Registration Marks for a Specific Application (When Using Alignment Mark in Print & Cut)

6.2	 What is the Barcode Cut Feature
6.3	 Adjust and Fine-tune the Cutting Conditions
6.4	 Useful Functions for Advanced Cutting
6.5	 Automated Weed Line Feature
6.6	 Multiple Copies of the Objects on the Same Media
6.7	 Advanced Way to Use Registration Marks
6.8	 How to Cut a Job larger than the Media (Using Tiling Function)

6.9	 How to Check the Cutting Plotter Information
6.10	Remote Control for Cutting Condition by PC
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6.1	 How to Use Registration Marks for a Specific Application (When Using Alignment Mark in Print & Cut)

Maximize your Cutting Area (Changing the Size and Shape of Registration Marks)

This allows wider cutting area by making the marks smaller or fewer.

Operation

	 1.	 Open "Registration Marks" panel, go to "Registration Marks" tab.

	 2.	 Click the drop-down arrow for "Style" of Registration Marks, and then select "Graphtec 3 points" or 
"Graphtec 2 points" to use.  
Click the drop-down arrow for "Length", and then select "5mm".

●	The slightest movement in the media may result in registration mark scanning error.  
Instead, practice one of the following techniques: Load the media as straight as possible.  
And/or increase the size of the registration marks.

●	If a very high accuracy between print and cut position is needed, always use the 4 point method 
of registration marks and maximum length.

Supplement
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Registration Marks for Your Specific Media (Changes Mark Color or Background Masking Color)

Registration Marks can be scanned for your specific media by either changing the mark’s color or simply adjusting 
background mark’s color.  
This is used when a normal black registration mark cannot read for specific media.

Operation

	 1.	 Open "Registration Marks" panel, go to "Color" tab.

	 2.	 Check the box in front of "Color".  
If you want to fill with color around Registration Marks on the selected object, check the box in front of the 
"Print Mask around Registration Marks".  
Check the box in front of "Color" under the "Print Mask around Registration Marks".  
You can resize your "Mask Width" to use by clicking on the slide bars.

Depending on your media type, it may not be able to read Registration Marks even if this option 
is set.  
It is possible that the registration marks cannot be read on all media types, it is not guaranteed.

Supplement
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Registration Marks for Longer Prints (Changing Segment area Adjustment Marks or Intermediate Marks)

A file can also be cut by reducing the movement of the media feed direction, you can perform cutting with less 
deviation.  
This is used when your jobs are skewed and misaligned during the printing and cutting process with a long.

Operation

	 1.	 Open "Registration Marks" panel, go to "Registration Marks" tab.

	 2.	 Click the drop-down arrow for "Style" of Registration Marks, and then select "Graphtec Segment Area Type1 
or "Graphtec Segment Area Type2" to use.  
This controls the distance from one segment mark to the next in the "X step".  
Click the drop-down arrow for "X Direction", and then select "Vertical" or "Horizontal" to use.
*	This sets which side of the media feed direction will be considered the X direction when the media is loaded.
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Advanced Cutting for Warped Prints (Graphtec XY Segment Area Type1, Graphtec XY Segment Area Type2)

Several materials are sensitive to ambient temperature, this may shrink, and some may expand after the image has 
been printed.  
The 4 Point Registration Mark method cannot compensated for media deformation moves, especially when there is 
bow deformation.  
In such cases, using the intermediate marks for the tool carriage and cutting direction (media movement), such 
as Self-adhesive vinyl materials, may give the cutter better control of the media and is likely to improve the cutting 
quality.

Operation

	 1.	 Open "Registration Marks" panel, go to "Registration Marks" tab.

	 2.	 Click the drop-down arrow for "Style" of Registration Marks, and then select "Graphtec XY Segment Area 
Type1" or "Graphtec XY Segment Area Type2" to use.  
This controls the distance from one intermediate mark to the next in the "X step".  
Click the drop-down arrow for "Y Intermediate Marks", and then select the number of marks for the Y cutting 
direction (Carriage movement).
*	This specifies the direction in which the tool carriage will be moved (Y direction) when the media is set on the 

preview screen.  
Click the drop-down arrow for "X Direction", and then select "Vertical" or "Horizontal".

*	This sets which side of the media feed direction will be considered the X direction when the media is loaded.

This "Y Intermediate Marks" option can only be used when the spacing is specified between each 
individual marks is 600mm or more. 
You may need to select a different number of marks is even when using the same condition set to 
600mm or more.

Supplement
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6.2	What is the Barcode Cut Feature

What is the Difference between Standard and Roll Media Barcode Options
Standard Barcode can be used to save barcode information to USB flash memory.  
Read the data linked to the barcode from the USB flash drive and printing and cutting.
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	 Registration Marks Type 1	 Registration Marks Type 2

Roll Media Barcode can be used to save barcode information to USB flash drive or Data Link Server.  
This can be output directly to the cutting plotter by sensing the barcode information corresponding to the barcode 
printed on the media.  
The Roll Media Barcode can be used to cut multiple jobs sequentially when the cutter will detect the marks for the 
second barcode automatically after the first job is done.   
In this way a complete roll can be cut for the multiple jobs without intervention of the user.

	

G1100JMAA-R

G1100JMAA-F

	

G1100JMAA-R

G1100JMAA-F

	 Registration Marks Type 1	 Registration Marks Type 2

For details on how to use Standard Barcode, see "5.2 Basic Workflow for Print and Cut with Barcode".
For details on how to use Roll Media Barcode, see "5.3 Data Link Workflow for Continuous Cutting (Barcode Data 
Management)".
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How to Scan Barcode with High-Intensity Reflective Film or Glossy Media
This is used when the user needs to be read the barcode with high-intensity reflective film or glossy media.

Operation

	 1.	 Start "Registration Marks" panel, then go to "Barcode" tab.

	 2.	 Click the checkbox in front of the "Use Barcode".

	 3.	 Click the drop-down arrow for "Barcode Type", and then select "Roll Media".

	 4.	 Select any barcode length from "Long (0.8mm)" to "Long (2.0mm)".
*	It is recommended to make sure that the barcode length is longer ensure the barcode scanner can read the barcode.

	 5.	 Go to "Registration Marks" tab.

	 6.	 Set "Thickness" to "1.0mm".

	 7.	 Set "Length" to "20mm".

●	"Scan Mode" needs to be set to "Mode 4" to perform optimal cut on the plotter.  
For details on how to set scan mode, refer to User's Manual on the cutting plotter device.  
This "Mode 4" should only be used with FC9000 or CE7000 series.

●	The high-intensity reflective films can only be used with the FC9000 Series.
●	It is possible that the registration marks cannot be read on all media types, it is not guaranteed.

Supplement
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6.3	Adjust and Fine-tune the Cutting Conditions

Configuring the Cutter Settings to Match the Properties of the Media by PC (Add, Save, Import)

This is used for easy adjusting when the cutting conditions are saved in the computer, it is not necessary to change 
this each time unless the media has changed.

●	"CONDITION PRIORITY" settings in the cutter's control panel need to be set as "PROGRAM".
●	"TOOL SELECT COMMAND" settings in the cutter's control panel need to be set as "ENABLED".

Supplement

Operation

	 1.	 Start "Cutting View" screen, go to "Option".

	 2.	 Check the box in front of "Enable Driver Options".  
Click on the "  " icon next to the "Condition Name" list.

Up to the eight types of presets can be saved in the "Condition Name" list.  
It can be useful to save the cutting conditions optimized for an often-used type of media as a 
preset.

Supplement

	 3.	 The "New Condition" dialog box will appear on the display.  
Enter a new condition name, then press "OK" button.
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	 4.	 Click the drop-down arrow for "Condition Name" and confirm your entry.  
Make the settings for the each cutting condition.

	 5.	 Click the drop-down arrow for "Condition No." and select one condition number from "1" to "8".  
Selecting "3", will use the operation according to the Condition No. 3.

For conditions two kinds of tool setting can be set at the same time, you can assign a tool 
number to each condition number.  
Before the first use, the tool setting needs to be preconfigured on the cutter.   
For example, the menu on the control panel shows the tool number with a plotter-type pen or 
knife with a pen, which was currently selected by condition No1.

Supplement

	 6.	 Check the box in front of "Speed", specify it with the slider bar or by typing in a specific value.  
If you specify "30", it moves at 30cm/sec for the speed of cutting.

If this "Speed" check box is disabled, use the speed setting which is set on the cutting plotter.Supplement

	 7.	 Check the box in front of "Acceleration", specify it with the slider bar or by typing in a specific value.  
If "2" is specified, it operates with Acceleration of two.

If this "Acceleration" check box is disabled, use the acceleration setting which is set on the 
cutting plotter.
The "Acceleration" will automatically be linked to the "Force", if the "Acceleration" check box is 
activated, it is also possible to activate a "Force".

Supplement

	 8.	 Check the box in front of "Force", specify it with the slider bar or by typing in a specific value.  
Selecting to "15", the cutter will operate according to the pressures of the blade at a fifteen.

If this "Force" check box is disabled, use the force setting which is set on the cutting plotter.
The "Force" will automatically be linked to the "Acceleration", if the "Force" check box is activated.

Supplement

	 9.	 Click the drop-down arrow for "Line Type", select one line type from "Style 1" to "Style 9".  
If "Style 1" is specified, this will operate as a solid line.
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	10. 	 Setting is completed, press the "  " icon next to the "Condition Name".

	11. 	 The "New Condition" dialog box will appear on the display. Confirm your setting and press "OK" button.

	12. 	 Repeat the procedure to find the optimal setting values and make the settings for the cutting conditions.
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Assigning/Outputting Cutting Conditions for Each Color or Layer
If colors (Cutting lines and Fill color)/layers are already predefined in the design, these colors/layers data can be 
used for assigning certain tools, can also be set for each tool such as Knife or Pen in each color/layer.

Operation

	 1.	 Start "Cutting View" screen, go to "Option".

	 2.	 Select either "By Color" or "By Layer".  
If you wish to deselect the Colors or Layers, you may remove them on the checkbox in the "Color"/"Layer" 
field.  
Specify the cutting order by Color or Layer of your desired driver options.  
Change the color or layer you want to cut to apply it by using the up and down arrow at the right side.
*	This By Layer option is only offered as an extra-cost option.

When you create the design, it is recommended that data be organized by color or by layer so 
that it can easily be processed.

Supplement
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	 3.	 Specify the cutting conditions you want to assign in each Color or Layer.  
Check the box in front of "Enable Driver Options".  
Specify the cutting condition by Color or Layer of your desired driver options.  
Click drop-down arrow for "Condition Name", then select one option to use.

●	If this "Enable Driver Options" check box is disabled, use the cutting conditions which is 
displayed on the cutting plotter.

●	You can create any condition that is displayed in the Condition Name.  
For details on how to create the cutting conditions, refer to "Configuring the Cutter Settings to 
Match the Properties of the Media by PC (Add, Save, Import) ".

Supplement
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Using the Perforated Cut Feature and Efficiency
This perforated cut option is not only to cut with the tool pressure completely up but also the forces are less and 
the risk that blade movement is smaller. This method more efficiently completes the cutting operation.  
This option will only be displayed on supported models.

Operation

	 1.	 Start "Cutting View" screen, go to "Option".

	 2.	 Check the box in front of "Enable Driver Options".  
Click on the "  " icon next to the "Line Type" at the right side.

	 3.	 The "Edit Custom Line Style" dialog box will appear on the display.

	 4.	 Enter any user-defined name in the "Custom Lines" field.

	 5.	 Click drop-down arrow for "Custom Type", select cut line pattern you want to use.

	 6.	 For Custom, enter the length of the cut to achieve deep cutting to "a", and enter the value not cut to "b".  
For Custom2 and Custom3, enter the length of the cut to achieve deep cutting to "a" and "c", and enter the 
value not cut to "b".

	 7.	 Press "OK" button to close "Edit Custom Line Style" dialog box.

	 8.	 Select a new Line Type in which it was created in the "Custom Lines".
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	 9.	 Check the "Cutting between Dashed Lines" to enable the cutting force between dashed lines.  
This specifies the blade pressure in the "Cutting Force between Dashed Lines" while tool up.

●	This "Cutting between Dashed Lines" will only be enabled available for selecting if a new 
custom line is specified.

●	This "Cutting Force between Dashed Lines" option will specify the blade pressure when the 
blade is not use for cutting in "Edit Custom Line Style".

Supplement
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How to Use Extra-Sticky Media
When using the extra-sticky media or a thin high-intensity reflective media, it may not operate properly due to 
an adhesive buildup on the blade tip. In this case, "Perforated Cut" function can be used to improve the cutting 
operation and efficiency.  
This option will only be displayed on supported models.

Operation

	 1.	 Start "Cutting View" screen, go to "Option".

	 2.	 Check the box in front of "Enable Driver Options".  
Click on the "  " icon next to the "Line Type" at the right side.

	 3.	 The "Edit Custom Line Style" dialog box will appear on the display.

	 4.	 Enter at any user-defined name in the "Custom Lines" field.

	 5.	 Click the drop-down arrow for "Custom Type", select "Custom 1".

	 6.	 Enter the length of the blade to 500mm (19.685 inches) for "a" (500mm in cut length).

	 7.	 Enter the length of the blade to 0.01mm (0.04 inches) for "b" (Not use cut length).

This is the length of values for reference purposes only.  
Perform test cuts to determine if the values are suited for your media.

Supplement

	 8.	 Press "OK" to close "Edit Custom Line Style" dialog box.

	 9.	 Select a new Line Type in which it was created in the "Custom Lines".

	10. 	 Check the box in front of "Cutting between Dashed Lines".
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	11. 	 Enter the value to "1" in the "Cutting Force between Dashed Lines" field.

●	This "Cutting between Dashed Lines" will only be enabled available for selecting if a new 
custom line is specified.

●	If the setting value is set at "1", but the cutting quality will not be improved, please click "Cutting 
Force between Dashed Lines" so that is deselected.

Supplement
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How to Use the Thick Media
This can be used to cut media that is too thick to be cut in one pass either when you repeat cut under the same 
cutting conditions or if the different conditions are combined.

In case the same cutting conditions are used in multiple passes

Operation

	 1.	 Start "Cutting View" screen, go to "Option".

	 2.	 Click the check box in front of "Enable Driver Options".

	 3.	 Click the drop-down arrow for "Condition No." and select one condition number from "1" to "8".

	 4.	 Enter the number of times to cut the same path for "Passes" field.  
For example, if you specify "2", then the blade will be cut the same path two times.
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Tool Carriage Controls by PC
It is possible to move the tool carriage to the origin point or outside cutting area after the cutting process is 
completed.

Operation

	 1.	 Start "Cutting View" screen, go to "Option".

	 2.	 Check the box in front of "Advance after Plot".

●	For grit roller type  
If this option is enabled, the media is advanced (fed) an exact distance from the cut object.
*	If sheets are used, the control panel displays a message prompting you to change the media.  

If this option is disabled, tool carriage will return to the origin position.
●	For Flatbed type  

If this option is enabled, the tool carriage will move to the end of the table.  
If this option is disabled, the tool carriage will return to the origin position.

Supplement

	 3.	 This specifies amount of media feed.

●	For grit roller type  
If this option is enabled, the media is advanced (fed) an exact distance to the end of object, and 
it should additionally be possible to advance the media by the specified value.
*	If sheets are used, the control panel displays a message prompting you to change the media.

●	For Flatbed type  
This function is not supported.

Supplement
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Cross Cut Feature Controls by PC after Completing Cutting
If you are using Roll Media, you can completely remove a sheet from the roll by using the crosscut function when 
the cutting is finished.

Operation

	 1.	 Start "Cutting View" screen, go to "Option".

	 2.	 Click the check box in front of "Advance after Plot".

	 3.	 Specify the distance the cutter in the "Additional Advance".

	 4.	 Click the check box in front of "Cross Cut".

●	For grit roller type  
This option performs the roll media crosscut automatically you can set or modify the distance 
the cutter will feed from a specified position by PC after cutting is finished.
*	This option is only available when the supported cutter is used.
*	If the sheets are used, the control panel displays a message prompting you to change the 

media.
●	For Flatbed type  

This function is not supported.

Supplement
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6.4	Useful Functions for Advanced Cutting

How to Check Cutting Data to Fit onto the Media Size
This option can be used to check whether the cut data size will fit onto the media before it is actually cut.

●	For grit rollers type, make sure to load the media and check whether the media set lever is lowered (Ready 
status).

●	For flatbed type, make sure to obtain the value that is the maximum cutting area width.  
If setting need to be changed, first change the cutting area width in the cutting plotter device.  
For details on how to change the Expand Settings, refer to User's Manual for cutting plotter device.

Supplement

Operation

	 1.	 Start "Cutting View" screen, then go to "General" tab.

	 2.	 Press the "Poll Size" button.  
This "Poll Size" button is used to obtain the size (cutting area) of the loaded media, show a quick preview of 
the data in the preview window.
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How to Check Cutting Area on the Cutter before Cutting Starts
The tool carriage, with the tool in the up position will move around using the maximum upper, lower, left, and right 
sides of a rectangle. This will allow you to check if the drawing will fit without actually cutting.

Operation

	 1.	 Start "Cutting View" screen, then go to "General" tab.

	 2.	 Press the "Show Bounds" button.  
The cutting plotter is used to draw a rectangular that matches Image Area.

●	For grit rollers type, make sure to load the media and check whether the media set lever is 
lowered (Ready status).

●	If you need to check the origin point, press the "Interactive" icon.  
"Interactive" when enabled moves the tool carriage as you change by either manually dragging 
the position of the object within the preview window or by typing in the desired position in X, Y 
direction.

Supplement
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Optimizing the Cutting Order for the Media (Preventing Misalignment)

Optimizing the cutting order will reduce the number of times the media moves back and forth, and the tool carriage 
moves from one side of the media to the other side.  
This may reduce media skew and improve efficiency.

Operation

	 1.	 Start "Cutting View" screen, then go to "Advance" tab.

	 2.	 Click the drop-down arrow for "Optimize Cutting Order", and then select Cutting Order.  
If you wish to reduce the time to cut, select "Speed Priority".  
If you wish to minimize media movement, select "Restrict Media Movement".  
If does not need special settings, then select "None".

If you select "None", the cutting is performed in the order the data is sent from the application.Supplement
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How to Avoid Uncut Areas or Non Clean Edges
The Overcut feature helps avoid any uncut areas when cutting a closed shape.  
The cutting line is extended by a specified length from the end point position so no gaps in the cut line are left.

Operation

	 1.	 Start "Cutting View" screen, then go to "Advance" tab.

	 2.	 Check the box in front of "Overcut", slide over cut length bar and apply it. 
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Optimize Cutting Direction for Closed Shape to Obtain better Cutting Quality
If the blade alignment changes frequently when cutting closed shapes, the cut quality may suffer.  
You can improve the cut quality by setting the blade cutting direction to clockwise or counterclockwise.

Operation

	 1.	 Start "Cutting View" screen, then go to "Advance" tab.

	 2.	 Click the drop-down arrow for "Cutting Direction", and then select cutting direction to use.  
If you wish to set all objects to be cut the same clockwise, select "Clockwise".  
If you wish to set all objects to be cut the same counterclockwise, select "Counter Clockwise".  
If special settings are not needed, then select "Original".
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Cut Length Result is Slightly Shorter than the Design Data about 0.5mm
The initial coordinate value (step size) is set to 0.1mm.  
If the cut length is shorter, setting the step size to 0.01mm may correct the situation.

Operation

	 1.	 Start "Cutting View" screen, then go to "Advance" tab.

	 2.	 Click the drop-down arrow for "Step size", and then select 0.01mm.

If changing the Step Size does not fix the problem, check to make sure the blade is not worn 
down and also check the "Distance Adjust" values.

Supplement



80

Chapter 6  Advanced Cutting for a Specific Application
Contents

Introduction Topics
Installation Guide

Basic Operation
Creating a Design

Barcode and Data Link Server
Advanced Cutting

6.5	Automated Weed Line Feature

Enables an Automated Weed Border to be Created around the Cut Job
This is used when the user wants to improve productivity and save time to add a rectangle around the bounding 
box of the job at a selectable distance.  
It makes it easier to remove the excess media from the media. Use the Weed Line menu to add a rectangle in order 
to facilitate weeding the cut.

Operation

	 1.	 Start the "Cutting View" screen, go to "Weed" tab, then check the box in front of "Weed Border".

	 2.	 Enter the desired margin space.

This can be used to set a selectable distance to add margin between the object and weed border.  
If the margin value is set to 0, weed border and object may overlap each other.  
It is recommended that you set the margin as appropriate for your cut job. 

Supplement
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Adds a Weed Line that Splits between Objects
This option allows the user to add horizontal or vertical Weed lines between characters at a selectable distance.  
This is very helpful to increase productivity and save time.  
It makes it easier to remove the excess media from the media.  
Use the Weed Line menu to add a rectangle in order to facilitate weeding the cut.

Operation

	 1.	 Start "Cutting View" screen, go to "Weed" tab.  
Check the box in front of "Weed Border", then select the appropriate weed line options. (Horizontal or 
Vertical Weed Lines, Horizontal or Vertical Split Lines.)
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6.6	Multiple Copies of the Objects on the Same Media
The Matrix Copy is an option to cut multiple copies when cutting the same object design that has been printed on 
the same media with equal distance between these objects.  
This saves you from having to manually copy and paste the same object in your design multiple times.

How to Specify Total Number of Copies of the Selected Object (Without Registration Marks)

Operation

	 1.	 Start "Cutting View" screen, then go to "Matrix Copy" tab.

	 2.	 The "Copies" option determines the number of copies.

	 3.	 The "X Spacing" option determines the vertical spacing between copies.  
The "Y Spacing" option determines the horizontal spacing between copies.

Copy will copy toward Y Position.  
If the multiple copies in a row is moved too far to the top.  
The software will automatically readjust the copies at the right inside the preview window.

Supplement
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How to Specify the Number of Copies that will be produced in X or Y Direction (When using Registration Marks)

Operation

	 1.	 Start "Cutting View" screen, then go to "Matrix Copy" tab.

	 2.	 The "X Copy" option determines the copies horizontally from the right.  
The "Y Copy" option determines the copies vertically from the bottom.

	 3.	 The "X Spacing" option determines the horizontal spacing between copies.  
The "Y Spacing" option determines the vertical spacing between copies.

The Matrix Copy is not supported on all cutter models.Supplement
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6.7	Advanced Way to Use Registration Marks

Preventing Media Skew When Cutting Long Material
When you want to use registration marks and cut long material, you can minimize media skew by using the 
"Segment by Segment" feature. The registration marks are read in each segment and cut, then the media is moved 
forward, and the process is repeated until all the segments have been scanned and cut.

Operation

	 1.	 Start the "Cutting View" screen, go to "Registration Marks" tab, then check the box in front of "Cut Segment 
By Segment".

●	You may visit our website and check the supported cutter.
●	Registration Marks must have been created with Graphtec Segment Registration Marks or 

Graphtec XY Segment.

Supplement
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How to Avoid Damaging the Printed Surface When Using Reverse side or Creasing Cutting

Easily create patterns to facilitate low-volume high-variety production
This is used when doing printing and cutting with "Reverse Registration Marks".  
The easiest way to get started with patterns and box creation to facilitate low-volume high-variety production.  
This option is not available on all models.

Operation

	 1.	 Creating data for printing & cutting.

	 2.	 Load the media on the cutting plotter.

	 3.	 Start "Cutting View" screen, go to "Registration Marks" tab, click the drop-down arrow for "Reverse Side 
Registration Marks", and then select "Cut Back Side (Low-volume production).

	 4.	 Select "Send To Cutter" and press "OUTPUT" button.

	 5.	 The cutter will start scanning the registration marks and cut out the marks on the reverse side of the media.

	 6.	 After removing the cropped marks, flip the media horizontally in a X direction and load the media again 
onto the cutting plotter.  
Make sure that the media is reloaded and matches the position which is set in step 2.

	 7.	 Press the "ENTER" key on the control panel of cutting plotter.  
The cutter will start scanning the registration marks and creasing and cutting are performed.
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Easily create the same objects for high-volume production
This is used when doing printing and cutting with "Reverse Registration Marks". You can efficiently create a large 
number of identical items.

Operation

	 1.	 Creating data for printing & cutting.

	 2.	 Load the media on the cutting plotter.

	 3.	 Start "Cutting View" screen, go to "Registration Marks" tab, and select "Cut Back Side (High-volume 
production)" from the Reverse Side Registration Marks.

	 4.	 Press "Cut Reg Marks (Send to Cutter)" button.

	 5.	 The cutter will start scanning the registration marks, cut out the marks on the reverse side of media.

●	If you wish to put a crease on the front side of the media, check the box in front of "Enable use 
of tools on the surface".  
You need to configure the data that is set front side in the "Option" tab before cutting.

●	If you wish to specify the cutting conditions are intended for reverse side registration marks, 
check the box in front of "Condition when cutting Reg Marks".  
In this case, cut out the marks on the reverse side of the media by using the cutting conditions 
set on the control panel of the plotter.

Supplement

	 6.	 After removing the cropped marks, reload the media onto the cutting plotter.  
Load and set your media again as originally positioned in step 2.

	 7.	 Cut out the part of marks only on the printed side by using COPY mode of the cutting plotter function.

	 8.	 After the marks are cut out for reverse side, perform the cutting process on the reverse side of the media.  
Flip the media horizontally in a X direction and load the media again onto the cutting plotter.  
Load and set your media again as originally positioned in step 2.
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	 9.	 Click the drop-down arrow for "Send To Cutter" and press "OUTPUT" button.  
Creasing and cutting are performed on the reverse side of the media after reading the marks on the cutter.

●	You need to configure the data that is used for the reverse side in the "Option" tab before 
cutting.

Supplement

	10. 	 Perform the cutting process on the reverse side of the media by using COPY mode of the cutting plotter 
function.

●	You may visit our website and check which cutters are supported.Supplement
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6.8	How to Cut a Job larger than the Media (Using Tiling Function)

Adjustment of the Tile Sizes and Positioning
This may be useful when the job is larger than the loaded media size, by dividing the job into several parts.

Operation

	 1.	 Start "Cutting View" screen, then go to "Tiling" tab.  
Check the box in front of "Tiling Active".  
Check the box in front of "Relative to Job" and select "Automatic".  
The job is divided into several parts.

	   
*With this option you can optimize the job for dividing 

them according to the media size of General tab.

●"Regular Grid" will resize the tiles to maintain width and height dimensions for the individual 
tiles.  
"Cell Width" and "Cell Height" will set the cell width or height for each tile.  
"Rows" and "Columns" will set the number of tiles in a row or column.

●	If you wish specify the size being divided in the preview window, you may edit the tile position 
by dragging the division lines and red control points.  
If you adjust the tile position and size manually, the check box will be changed automatically to 
the "User Defined" or "Custom".

Supplement



89

Chapter 6  Advanced Cutting for a Specific Application
Contents

Introduction Topics
Installation Guide

Basic Operation
Creating a Design

Barcode and Data Link Server
Advanced Cutting

How to Overlap Between the Tiles
By overlapping the tiles onto the adjoining tiles, you can eliminate any gaps between the tiles when mounting the 
tiles after they have been cut.

Operation

	 1.	 Start "Cutting View" screen, go to "Tiling" tab.  
Check the box in front of "Tiling Active".  
Manually slide an overlap margin bar or enter a specific value and apply it.  
An overlap margin will be defined in orange color.
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How to Cut Only Selected Tiles
There is also the option to cut out each tile separately.  
With the "OUTPUT" button, the tile can be used again sent to the cutter.

Operation

	 1.	 Start "Cutting View" screen, go to "Tiling" tab.  
Check the box in front of "Tiling Active".  
This option allows for selected tiles only to be cut. you may click in the preview on the tiles and enter the 
specified tile number.  
For example, if you wish to output the tiles that specified numbers at 1 to 3,5 and 7 among the eight tiling, 
you can enter 1-3,5,7.

	

Clicking on a tile will toggle it between disabling or enabling the tile.
When a tile is enabled, it will become a light blue color. 

Supplement
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6.9	How to Check the Cutting Plotter Information
The cutter information can be obtained from Plotter information tab, check your plotter information before you 
contact your support section.

Checklist for Getting Support

Operation

	 1.	 Start "Cutting View" screen, then go to "Plotter Information" tab.

	 2.	 Write down and complete the cutter information, such as "Model", "Firmware Version" and "Serial Number".
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6.10	Remote Control for Cutting Condition by PC
You may adjust the menu value that is frequently used from your computer.  
You may also adjust the configuration value by using "Remote Panel Utility".

What is the Remote Panel Utility
This controls the configuration value by PC.  
Allows you to retrieve the configuration value of each menu from the cutter along with remote control and 
monitoring by PC.  
You may change the configuration value on the PC, and data updates will be sent to the cutting plotter.  
The configuration value can be obtained from the cutting plotter.  
You may save it in a file and can be backed up to a removable or external memory device as desired.  
And the same configuration values may get transferred to the another cutting plotter.

●	The configuration menu differs depending on the connected cutting plotter.
●	Make sure that the cutter is completely connected with the PC by using USB or LAN cable connection.
●	Make sure that the cutter is in the READY status.

Supplement
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Remote Controlling the Cutter's Configuration Value by PC
You may remotely change the configuration value which is performed on the cutting plotter device by PC.

Operation

	 1.	 Start "Cutting View" screen, then go to "Plotter Information" tab.

	 2.	 Press the "Remote Panel Utility" button.

	 3.	 Remote Panel Utility is started.  
Change the configuration value of menu which you wish to cut.

	 4.	 If the setting changes are completed, then press "OK" button.  
It makes it possible to send the configuration value to cutting plotter and update it.

If you do not send your changes, press "Cancel".Supplement
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How to Back Up the Cutter's Configuration Value
You may back up your cutter's configuration value that is displayed in the "Remote Panel Utility" screen.  
You may can choose to back up a specific "Condition" tab only or all that you have selected.

Operation

	 1.	 Start "Cutting View" screen, then go to "Plotter Information" tab.

	 2.	 Press the "Remote Panel Utility" button.

	 3.	 Remote Panel Utility is started.  
If you want to back up only cut condition, simply press the "  " icon in "Condition" tab.  
If you want to back up all the settings that you have selected, go to "Help" tab, then press the "Save All" 
button.

	

	 4.	 The "Save As" dialog box will appear. Save to any specified location with a name on your computer.
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How to Use the Backed-Up File
These backed files not only control the cutter's own configuration value but also other cutter’s configuration values, used 
for the copy settings If a new cutter is set up or if the multiple cutters are connected two or more at the same time.

Operation

	 1.	 Start "Cutting View" screen, then go to "Plotter Information" tab.

	 2.	 Press the "Remote Panel Utility" button.

	 3.	 Remote Panel Utility is started.  
If only "Condition" tab values need to be sent to the cutter, select the "  " icon.  
If you are sending all the configuration values of the "Condition" tab to the cutter, go to "Help" tab, then 
press the "Load All" button.

	

	 4.	 The "Open" dialog box will appear, select the saved file to reflect the changes.  
The configuration values are reflected on the "Remote Panel Utility" screen.

	 5.	 If the setting changes are complete then press "OK".  
This makes it possible to send the configuration value to cutting plotter and it will be updated.

If you do not send your changes, press "Cancel".Supplement
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